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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at laese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemarkninger angadende
brugen af din skaerm.

Philips garanti deekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
stad, elektriske ulykker og/eller mekaniske
ulykker.

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm:

Betjening
* Hold skeermen vak fra direkte sollys og
vk fra breendeovne og andre varmekilder.

* Fjern alt, der kan risikere at falde i
ventilationsabningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

*  Bloker ikke ventilationsdbningerne pa
kabinettet.

» Under placering af skeermen skal du sikre
dig, at det er let at komme til stregmstikket
og stikkontakten.

*  Hvis der slukkes for skeermen ved at fjerne
stremkablet eller jeevnstrgmsledningen,
skal du vente 6 sekunder, for du setter
stremkablet eller jeevnstremsledningen til
igen for at opna normal betjening.

*  Brug altid et godkendt strgmkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udseet ikke skeermen for kraftige
vibrationer eller stad under anvendelse.

*  SIa ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skeermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at lgfte den. Laft ikke
skeermen ved at satte din hand eller fingre
pa LCD skarmen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en lengere periode.

* Tag stikket ud at kontakten til skeermen,
hvis du skal rengere den med en let fugtet
klud. Skeermen kan terres af med en ter
klud, nar der er slukket for strgmmen.
Under alle omstaendigheder, ma der ikke
bruges organiske oplgsningsmidler til
rengering af din skaerm.

* For at undga risiko for elektrisk sted eller
permanent beskadigelse af anleegget, ma du
ikke udseette skaermen for stev, regn, vand
eller miljiger med hej fugtighed.

e Hvis din skeem bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

*  Huvis der kommer fremmed substans eller
vand ind i skaermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

*  Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der
er indenfor fglgende temperatur- og
fugtighedsomrade.

e Temperatur: 0-40°C 32-95°F
*  Fugtighed: 20-80 % RH



*  VIGTIGT: Serg altid for at aktivere
en pauseskeerm, der beveeger sig, nar
skaermen efterlades uden at blive anvendt.
Du skal altid bruge en pauseskeaerm
eller et andet program, der opdaterer
skeermen regelmaessigt, hvis skeermen
viser statisk materiale i leengere perioder.
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage "“brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spegelsesbilleder” pa skaermen.

“Breendmaerker”, “efterbilleder”, og
“spegelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmaerkerne” eller
“efterbilledet” eller “spagelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede”-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennaevnte skade
er ikke deekket af garantien.

Service
* Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Huvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter’)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

6 Bemaerk

Kontakt en servicetekniker; hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, nar betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

| hele denne vejledning kan tekstafsnit veere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som folger:

© Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program

please visit www.philips.com/about/
sustainability/recycling,



2. Opsatning af skaerm
B Installation af stander

2. OPS&tnmg af skaerm 1. Anbring skeermen med forsiden vendt

nedad pad en bled og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

a Emballagens indhold

Start

T o 2. Hold pa foden med begge heander, og szt

med en fast hand foden ind i fodsgjlen.

(1) Fastsger forsigtigt foden til fodsgjlen
indtil ldsen ldser den pa plads.

(2) Brug dine fingre til at fastspaende skruen
under foden, og serg for at foden er
ordentlig fastspaendt pa sgjlen.

VGA (valgfri) DVI (valgfri)




2. Opsatning af skaerm

E Tilslutning il PC
Model 227E3L:

PHILIPS

0 ~c stremindgang
VGA-indgang
DVI-D-indgang
Kensington anti-tyverisikring

Model 227E3LH:

PHILIPS

O Ac stremindgang
© \GA-indgang
DVI-D-indgang
HDMI indgang
(5] Lyd-indgang
Lydudgang
Kensington anti-tyverisikring

Model 227E3LPH:

PHILIPS

o 000
rﬂm C’:Q?Q
o Efﬂg

O ~c stremindgang

VGA-indgang
DVI-D-indgang

O HDMi indgang

HDMI lydudgang
Kensington anti-tyverisikring

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skaermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Seet computerens og skaermens
netledninger til et stik i neerheden.

Teend for computeren og skaermen. Hvis
skeermen viser et billede, er installationen
gennemfert.



2.2 Brug af skeerm

PHILPS

El Produktbeskrivelse set forfra
Model 227E3L:

Model 227E3LH:

(5]
/v /A 17/4 /0K [0}
| | [\ | |
(7] (6] o O (2] o
@ | O |[Tender og slukker for skermen.
Sédan far du adgang til OSD-
0 B/0K menuen.
Ga tilbage til det forrige OSD-
o < niveau.
O | 1Q |uster lydstyrken.
© | A V¥V [Tiljustering i skeermmenuen.
O | ©® |Skifter tilslutningskilden.
Smartlmage Lite. Der kan vaelges
@ | B |mellem tre funktioner: Standard,
Internet og Game (Spil).

Model 227E3LPH:

(5]

/v /A SENSOR/ < /0K [0)

| | [\ | |
(7] (6] ©O e o (1]

/e\
@/v /A /4 /0K [0)
| | [\ | |
(7] (6] O e o o
@ | (O [Tender og slukker for skaermen.
Sadan far du adgang til OSD-
0 S/0K menuen.
Ga tilbage til det forrige OSD-
o < niveau.
O [0 skifttil 43 format.
© | AV [Tiljustering i skeermmenuen.
0@ -©® Skiftertilslutningskilden.
Smartimage Lite. Der kan valges
0 B |mellem tre funktioner: Standard,
Internet og Game (Spif).

(1) @ [Tender og slukker for skarmen.
Sadan far du adgang til OSD-
9 E/0K menuen.
Ga tilbage til det forrige OSD-
o < niveau.

Indstil sensorniveauet pa den
SENSOR |automatiske justering af bag-
grundslyset.

A 'V [Tiljustering i skeermmenuen.

©  [Skifter tilslutningskilden.

Smartlmage Lite. Der kan veelges
@Y |mellem tre funktioner: Standard,
Internet og Game (Spil).

© o606 o




2. Opsatning af skarm

B Beskrivelse af OSD-visningen Grundlzggende og enkle anvisninger til

) X kontrolknapperne
Hvad er OSD (On-Screen Display)’ | skeermmenuen ovenfor, kan du bruge

Visning pa skeermen [On-Screen Display V A knapperne foran pd skeermen til at flytte
(OSD)] er en funktion pd alle Philips LCD markeren med, og tryk pa OK knappen, til at
skeerme. Den saetter en slutbruger i stand bekrafte dit valg eller &ndring.

til at justere skaermindstillingerne, eller

veelge skeermens funktioner direkte via et OSD-menuen

instruktionsvindue pa skeermen. Et brugervenligt

OnSVIn : Nedenstdende er en generel oversigt over
skaermvisningsinterface vises som nedenfor:

strukturen i OSD-displayet. Du kan anvende
den som opslag, ndr du senere skal orientere
dig i de forskellige justeringen.

Model 227E3L:

Main menu Sub menu
— Power Sensor [ on 04
Off
(available for selective models)
— VGA
— Input
F— DVI (available for selective models)
L— HDMI (available for selective models)
r— Picture Format — Wide Screen, 4:3
t— Picture
F— Brightness — 0~100
— Contrast — 0~100
[— SmartResponse ~ —— On, OFf (available for selective models)
—— SmartContrast — On, Off
r— Volume —— 0~100 (available for selective models)
— Audio
— Stand Alone — On, Off
— Mute — On, Off
r— Color Temperature — 6500K, 9300K
— Color
— sRGB
— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Francais, Deutsch, ltaliano,
Portugués, Pycckuit, i{EHISZ, Tirkge
Model 227E3LPH:
r— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
— Transparency — Off1,2,3,4
— OSD Time out — 510,20, 30, 60
L seep — Auto
— Power LED — 0,1,2,3,4
— Over Scan — On, Off (available for selective models)
— H. Position — 0~100
— V. Position — 0~100
[— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




2. Opsatning af skaerm

El Meddelelse om oplasning

Denne skarm er fremstillet til optimal ydelse
pa dens native oplgsning, som er 1920 x 1080
@ 60 Hz. Nar skeermen bruger en anden
opl@sning, ses falgende advarsel pa skeermen:
Brug 1920 x 1080 @ 60 Hz for at opna det
bedste resultat.

Advarslen vedrgrende den naturlige oplgsning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

a Fysisk funktion
Vip

2.3 Fjern standeren og foden

Bl Fjernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undga mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jaevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2. Fjern foden fra sgjlen, ved at:

(1) Bruge dine fingre til at Izsne skruen pd
bunden af foden.

(2) Treek langsomt foden op og ned for
at dbne lasen, der fastholder foden, og
treek langsomt foden af sgjlen.




2. Opsatning af skarm

2] Fiernelse af foden

1. Du kan bruge en almindelig skruetraekker
til at stikke ind i de to frigivelseshuller pa
haengslet, og lirk forsigtigt i heengseldeekslet
for at fierne det.

2. Fjern de 4 skruer og fiern derefter foden
fra skaermen.




3. Billedoptimering

3.1 Smartlmage Lite

El Hvad er dette?

Smartlmage Lite er forudindstillede indstillinger,
der optimerer skarmen i henhold til indholdet,
og som indstiller den dynamiske lysstyrke,
kontrast, farve og skarphed i realtid. Uanset om
du arbejder med tekstprogrammer; ser billeder
eller ser video, sa giver Philips Smartimage Lite
den optimale skaermydelse.

E Hvorfor behaver jeg det?

Du gnsker en skerm, som giver det bedste
billede for alle typer indhold. For at @ge skaerm-
oplevelsen, indstiller Smartlmage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed

i realtid.

El Hvordan virker det?

Smartlmage Lite er en eksklusiv, farende
Philips-teknologi, som analyserer indholdet pa
skaeermen. Ud fra det valgte scenarie forbedrer
Smartimage Lite dynamiske billeders og
videoers kontrast, farvemaethed og skarphed for
at forbedre det viste billede - alt i realtid og blot
med et tryk pa en knap.

Bl Hvordan aktiveres Smartlmage Lite?

1. Tryk & pa for at starte Smartlmage Lite
pa skaermen;

2. Tryk gentagende gange pa BD for at skifte
mellem Standard, Internet og Game (Spil).

3. Smartlmage Lite ses pa skeermen i fem
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sekunder, men du kan ogsa trykke pa OK
for at bekreefte det.

4. Nar Smartlmage Lite er aktiveret,
deaktiveres sRGB systemet automatisk.
For at bruge sRGB skal du deaktivere
Smartimage Lite med BD foran pa
skaermen.

Udover at bruge BD til at rulle ned med, kan

du ogsa trykke pa ¥ A for at veelge og derefter
trykke pa OK for at bekrafte valget og derefter
igen lukke Smart-billede OSD.

Der kan velges mellem tre funktioner: Standard,
Internet, Game (Spil).

@ SmartImage '™

Standard

Internet

Game

e Standard: Forbedrer teksten og deemper
lysstyrken for, at @ge leesbarheden og
nedsaztte anstrengelsen af gjnene.
Denne funktion gger leesbarheden og
produktiviteten, nar der arbejdes med
regneark, PDF filer; skannede artikler og
andre generelle kontorprogrammer.

* Internet: Denne funktion kombinerer
farvematheden, den dynamiske kontrast
og skarphed for at vise billeder og lignende
klart og i levende farver - alt uden synlige
fejl pa det skannet billede og blegnede
farver

*  Game (Spil): Aktivér overdrive-kredslabet
for at fd den bedste reaktionstid,
reducere skeeve kanter pa genstande, der
bevager sig hurtigt pa skaermen, forbedre
kontrastforholdet mellem lyse og marke
omrader. Denne funktion giver brugeren
den bedste spilleoplevelse.



3.2 SmartContrast

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pa en mark
baggrund.

B Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, laesbar tekst ved kontorarbejde.Ved at
nedsaette skeermens stremforbrug, sparer du
energiomkostninger og forlaenger skarmens
levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og
baggrundslysets intensitet indstilles. Denne
funktion forbedrer den dynamiske kontrast og
giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.3 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hgrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplgsning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er
udstyret med den seneste teknologi i algoritmer
for hurtig behandling og reaktion, og er tilmed
Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skeermel

11

El installation

* Felg instruktionen og fuldfer installationen.

¢ Du kan starte, nar installationen er fuldfart.

*  Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
veerktajslinjen.

PHILIPS e g e picerr

Opstartsguide
» Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
abner programmet ferste gang.
*  Guiden leder dig trin for trin gennem
indstillingen af skeermen.
*  Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.
» | Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.
[ P 3. Pion 1728 soo00l) X
SmartControl Lite PHILIPS

Wizard




3. Billedoptimering

Bl Start med Standard-vinduet: i e
SmartControl Lite PHILIPS

soocen) [T

Adjust menu (Indstillingsmenu):

*  Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken), |
Contrast (Kontrast), Focus (Fokus), Position |

(Position) og Resolution (Oplasning).

+  Udfer indstillingen ved at folge u »

instruktionerne. an = e
| . - ;
* Installationen kan annulleres med Cancel & - .
(Annuller). - # i e
B Sartczerl 3- Paign 12501 EsaeT13000001) ik \g B
SmartControl Lite PHILIPS =
Brightness
| : [P 3- P 2791 (e 3eris000001) (%
| 0 ' SmartControl Lite PHILIPS
: Position
\‘ - Y
e ¢ . |
ot o - L —
e - " ,g
Optony # i
[~ P 3 s 22993 tesaeresone0nt) (Dt \Q e
SmartControl Lite PHILIPS =

[Fpe—— 3 i 1791 (cs3sLs000001) () %

| 1 :
| g " ) SmartControl Lite PHILIPS

= = |
N e
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3. Billedoptimering

Color menu (Farvemenu):
*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),

White Point (Hvidpunkt), Color Calibration

(farvekalibrering) og Smartimage Lite (se
afsnittet Smartimage Lite).

»  Udfer indstillingen ved at folge

instruktionerne.

* Se nedenstdende oversigt med
undermenupunkter baseret pa din

indtastning.

*  Eksempel pa Color Calibration

(farvekalibrering):
S

SmartControl Lite

-

LA
Lew

\Q *:

[ ot

SmartControl Lite

it}
PHILIPS

Black Level

Back Lowel wil et 1 3 s o
o Arias, At the Slark: £ owed

it}
PHILIPS

White Point
Wiite Pont

13

p——— 3 s 12501 (63000001 X
PHILIPS

SmartControl Lite

Display Gammiy

B eurimes 3- P 12501 esaorisonsont) (X
PHILIPS

SmartControl Lite

Calibration

\? ”ﬁ.‘

“Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6é-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleser fer/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal veere patentoplysninger pa
kalibreringsskaermen.



Forste farvekalibreringsskaerm: rullemenuen. P4 en ikke-understattet skaerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

[ P 3 - Pl 12501 [C530713000001) X

SmartControl Lite PHILIPS

Preferences.

2
x>
*  Previous (Foregdende) knappen er -
deaktiveret, indtil du gar videre til den B
anden farveskaerm. g
*  Next (Neaste) gar til efterfelgende mal =
(seks mal). . 3
»  Gatil sidst til File > Presets (File > Forvalg)
vinduet.
*  Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden. * Viser nuvarende, foretrukne indstillinger.

* Funktionen aktiveres ved at afmarke feltet.
Afmerkningsfeltet er en flip-flop.

* Enable Context (Aktiver Indhold) menuen
er som standard afmerket (Til) pa
skrivebordet. Menuen Enable Context

Smartlmage Lite

Smart-Billede - tillader brugeren at zendre
indstillingerne, for at opnd en bedre
skaermindstilling baseret pa indholdet.

Nar der indstilles pa Entertainment (Aktivér kontekst) viser valgmulighederne i
(Underholdning), aktiveres Smart-Kontrast og SmartControl Lite pa Select Preset (Veelg
Smart-Svar Forvalg) og Tune Display (Indstil Display)

i genvejmenuen ved at hgjreklikke pd
skrivebordet. Disabled (Deaktiveret) fierner
SmartControl Lite fra genvejsmenuen.

* Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmeerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) ger, at systembakkens

\g :' ikon til SmartControl Lite vises. Et hajreklik
- | ™

1 Smarttzenl L
SmartControl Lite PHILIPS

SmartImage
St

pa jobbakke-ikonen viser menufunktionerne
. for Help (Hjeelp), Technical Support

- (Teknisk Support), Check for Upgrade

Zh (Tjek efter opgraderinger), About (Om) og
Exit (Afslut). Nar Enable Task Tray (Aktiver
Jobbakke) menuen er deaktiveret, viser
jobbakke-ikonen kun EXIT (AFSLUT).

* Run at Startup (Ker ved opstart) er
Options > Preferences (Funktioner > som standard afmeerket (Til). Nar den
Indstillinger) - er kun aktiv, nar Preferences er deaktiveret, starter SmartControl Lite
(Indstillinger) er valgt i Preferences (Funktioner)-

)
5
i% 1)
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3. Billedoptimering

ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan

kun startes fra genvejen pa skrivebordet
eller fra programfilen. Intet forvalg, som er
indstillet til at kere ved opstart, indleses
nar denne boks ikke er afmeerket (er
deaktiveret).

* Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows
7,Vista, XP). Standard er 0%
uigennemsigtighed.

Options > Input (Funktioner > Indgang)

- er kun aktiv, nar Input (Indgang) er valgt i
Options (Funktioner) rullemenuen. Pa en ikke-
understgttet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.
Alle andre faneblade i SmartControl Lite er ikke
til radighed.

SmartControl Lite PHILIPS

Input

EPORTANT!

‘! i iw {‘ TR

Arsiog in

* Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

* P4 enkeltindgangsskeerme ses dette vindue
ikke.

Options > Audio (Funktioner > Lyd) - er
kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pd en ikke-understattet skeerm med DDC/CI

er kun Help (Hjeelp) og Options (Funktioner) til
radighed.
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Help > User Manual (Hjzlp >
Brugervejledning) - er kun aktiv, nar User
Manual (Brugervejledning) er valgt i Help
(Hjeelp) rullemenuen. Pa en ikke-understattet
skeerm med DDC/CI er kun Help (Hjeelp) og
Options (Funktioner) til radighed.

PHILIPS

SmartControl Lite

User Manual

Help > Version (Hjzlp > Version) - er kun aktiy,
narVersion (Version) er valgt i Help (Hjelp)
rullemenuen. Pa en ikke-understattet skeerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.



[y Tx
SmartControl Lite PHILIPS

Version

Context Sensitive (Indholdssensitiv) menu

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmaerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

@ SmartControl
Select Preset L4
Tune Display

Context menuen har fire punkter:

*  SmartControl Lite - nar valgt, ses About
(Om) skaermen.

*  Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

*  Tune Display (Indstil Skaerm) - dbner
kontrolpanelet til SmartControl Lite.

*  Smartlmage Lite - Kontroller nuvaerende
indstillinger, Standard, Internet, Game (Spil).

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hgjreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:

*  Help (Hjzlp) - adgang til
brugervejledningsfilen: Abner
Brugervejledningen med standard
browservinduet.

»  Technical Support (Teknisk Support) - viser
siden med teknisk support.

»  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

*  About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite.

Hvis du vil kere SmartControl Lite igen,

skal du enten veelge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

PHILIPS

diune-standard-S2007-01-04-1151-23
Copyright 19832007 Portrat Displays, inc.
Pazsere fanang

Task Tray (Jobbakke) menu deaktiveret
NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).



4. PowerSensor™

(Kun pa 227E3LPH modellen)

PowerSensor er en unik miljgvenlig teknologi fra Philips, som giver brugeren mulighed for at spare op
til 80% af stremforbruget. Ligesom Philips Sense og Simplicity drey, virker denne brugervenlig teknologi
uden at det er ngdvendig at installere hardware eller software, og uden at brugeren skal gare noget i
standardtilstanden.

Kl Hvordan virker det?
*  PowerSensor udsender og modtager harmlgse “infrargde” signaler; sa den kan finde brugerens
tilstedevarelse.

* Nar brugeren er foran skaermen, bruges de indstillinger; som brugeren selv har sat, f.eks. lysstyrken,
kontrasten, farver osv.

* Antages det for eksempel, at skaermen var sat til 100% i lysstyrke, og brugeren forlader hans/
hendes saede og ikke leengere sidder foran computeren, sa reducere skaeermen automatisk
stremforbruget til 80%.

Bruger sidder foran skarmen Bruger ikke til stede

Stremforbruget, som er vist ovenfor; er udelukkende til reference.

HE indstilling

Standard indstillinger

Pa standardindstillingen (indstilling 3), er PowerSensor fremstillet til at finde tilstedeveerelsen af en
bruger, hvis han/hun er mellem 90cm og 110 cm (35,4 og 43,3 tommer) fra skaermen, og indenfor 5
grader til venstre eller hgjre fra skeermen.

Brugerdefinerede indstillinger

* Hvis du @nsker at vaere et sted udenfor det ovennavnte omradet, skal du veelge en hgjere
signalstyrke, for at opna en optimal detekteringseffekt: Jo hgjere indstillingen er sat til, jo steerkere
er detekteringssignalet. For at opna en maksimal effektivitet og ordentlig detektering med
PowerSensor, bedes du sidde direkte foran skarmen.

*  Huvis du veelger at sidde mere 110 cm eller 43,3 tommer vak fra skeermen, skal du bruge det
maksimale detekteringssignal, som har en afstand pa op til 130 cm eller 51,2 tommer: (indstilling 4)

* Da merkt tgj her en tendens til at absorbere infrargde signaler; selv hvis brugeren sidder indenfor
100cm eller 40 tommer af skaermen, bedes du skrue op for signalstyrken, hvis du har sort eller
meorkt tg) pa.

* Du kan altid vende tilbage til standardindstillingen (indstilling 3)
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4. Stremsenson

Genvejstast Sensor-afstand

oiv ROINN SENSOR/ 4 /oK o

_—

E sidan justere du indstillingerne

Hvis PowerSensor ikke virker ordentligt indenfor eller udenfor standardomradet, finindstiller du
detekteringen pa felgende made:
*  Tryk pa PowerSensor-genvejstasten.

* Herefter kan du se standardindstillingen '3’ pa justeringsbjeelken.
*  Stil PowerSensor-detekteringen pa 4 og tryk pa OK.
* Test den nye opsatning, for at se om PowerSensor finder dig ordentligt i din nuvaerende placering.

© Bemark

En manuelt indstillet PowerSensor vil forblive i drift, medmindre eller indtil den genindstilles, eller hvis
den justeres tilbage til standardindstillingerne. Hvis du synes at PowerSensor er alt for falsom overfor
neerliggende bevagelser, skal du justere til en lavere signalstyrke.

18



5. Tekniske specifikationer

Skeermpaneltype TFT-LCD
Baggrundslys LED
Panelstarrelse 21,5"W (54,6cm)
Billedforhold 169

Pixel pitch 0,248 x 0,248 mm
Lysstyrke 250 cd/m?
Smart-kontrast 20.000.000:1
Kontrastforhold (typ.) 1000:1
Reaktionstid (norm.) 5ms

Optimal oplasning

1920 x 1080 pa 60 Hz

Synsvinkel 170° (H) / 160° (V) ved C/R > 10
Billedforbedring Smartlmage Lite

Skeermfarver 16,7 M

Vertikal opdateringshastighed 56Hz - 76Hz

Horisontal frekvens 30kHz - 83kHz

sRGB JA

DVI (digital), VGA (Analog),

Inputsignal HDMI (p& modellerne 227E3LH, 227E3LPH)
Inputsignal Separat synk, synk. pa gren
227E3L  @/v ©/A /4 S/0K 0]
Brugerfunktioner 227E3LH: ®@p/v ©/A 17/4 /0K [0)
227E3LPH: Ep/v ©/A SENSOR/ < /0K )
OSD s Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk,

portugisisk og tyrkisk

Andre funktioner

Kensington-las

Vip

"Plug & Play" kompatibilitet

DDC/CI, sRGB, Windows 7/Vista/XE Mac OSX, Linux

-5/+420

Tendt-tilstand

27E3L 218W (typ)
207E3LH: 21,8 W (typ.), 27 W (maks))
227E3LPH: 21,8 W (typ.), 24 W (maks.)

Energiforbrug

(EnergyStar 5.0 testmetode)

AC AC AC
indgangsspaending | indgangsspaending indgangsspeending
ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-

S5VAC, 50Hz +/- 5VAC, 60Hz +/- 5VAC, 50Hz +/
3Hz 3Hz -3Hz
Normal funktion (typ.) 184 W 184 W 185W
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Sovetilstand 0,5W 0,5W 0,5W
Fra 0,5W 0,5W 0,5W
AC AC AC
indgangsspeending indgangsspanding indgangsspeending
Varmetab* ved 100VAC +/- ved 115VAC +/- ved 230VAC +/-
5VAC, 50Hz +/- 5VAC, 60Hz +/- 5VAC, 50Hz +/
3Hz 3Hz -3Hz
Normal drift 62,8 BTU/t 62,8 BTU/t 63,14 BTU/t
Sovetilstand 1,71 BTUA 1,71 BTU/t 1,71 BTUA
Fra 1,71 BTUA 1,71 BTU/A 1,71 BTUA
Strgmdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Stremforsyning Indbygget, 100-240VAC, 50/60Hz

Produkt uden fod (B x H x D) 534,34 x 4079 x 216 mm

Produkt uden fod (B x H x D)

534,34 x 335,89 x 41,1 mm

Myndighedernes godkendelser

Produkt med fod 4,01kg

Produkt uden fod 347kg

Produkt med emballage 417kg

Temperaturomrade (drift) 0°C til 40°C

Temperaturomrade o 1 o

(Ikke drift) -20°C til 60°C

Relativ fugtighed 209% til 80%

Hoid Betjening: + 3.658 m (12.000 fod)
ejce lkke drift: + 12192 cm (40.000 fod)

MTBF 30.000 timer

ROHS JA

EPEAT Silver (www.epeat.net)

Emballage 100 9% genbrugelig

CE Mearket, FCC Klasse B, GOST, SEMKO, TCO Godkendt,
UL/cUL, BSMI, 1SO9241-307

Farve Sort (bagside), Bla (forside)
Overflade Blank
@ Bemaerk

1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net

for registreringsstatus i dit land.

2. Disse data kan &ndres uden varsel. Ga til www.philips.com/support for at hente den seneste

version af brochuren.
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.Tekniske specifikationer

5.1 Oplasning og forudindstillede
funktioner

El Maksimal oplesning
1920 x 1080 ved 60 Hz (analogt indgang)
1920 x 1080 ved 60 Hz (digital indgang)
B Anbefalet oplesning
1920 x 1080 ved 60 Hz (digital indgang)

480i 720x480 | SD (60
480p 720x480 | SD |60
576i 720 x 576 | SD |50
576p 720 x 576 | SD |50
720p | 1280 x 720 | HD |50, 60
1080i | 1920 x 1080 | HD (50, 60
1080p | 1920 x 1080 | HD (24, 25, 30, 50, 60

S Bemeark

Bemzerk venligst at din skaerm virker bedst med
native oplgsning pa 1920 X 1080 ved 60Hz. For
at opna den bedste skaermkvalitet, bedes du
venligst bruge denne oplasning.
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6. Stromstyring

Hvis der er installeret et skaermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skeermen automatisk
nedsatte stromforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skaeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

VESA )
tilstand Video [V synk | Lsynk [ Opbrugt strem | LED Farve
Aktiv TIL Ja Ja  |<218W (norm.) Hvid
. : ; Hvid
Sovetilstand | FRA Nej Nej | <05W (norm.) (blinker)
Kontakt Fra [ FRA - - <05W (norm.) FRA

Folgende opsatning bruges til at male
skaermens strgmforbrug.

* Indbygget oplasning: 1920 x 1080
*  Kontrast: 50%
e Lysstyrke: 250 nits

* Farvetemperatur: 6500k med fuldt, hvidt
mgnster

@ Bemaerk
Disse data kan andres uden varsel.
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7. Lovmaessige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!
This display is designed for both you and the

planet
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.
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*  Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

e Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

*  Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of [T equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and IT-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[u Technology for you and the planet
CERTIFIED



EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

» EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

»  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

»  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

* EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

»  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

» TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



. Lovmassige oplysninger

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en

EN 55022 Compliance (Czech Republic Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it i a Class A devics on the epeciication labal. The following apglies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The user of the
davics is obliged to take all stapa necessary o remove sources of interfsrence io tela-
communication or other devicas.

Pokud neni na typovém Stitku po&itade uvedeno, 28 spadé dodo tfidy A podie EN 55022,

do tfidy B podie EN 55022. Pro zafizen zafazend do thidy A (chranné
péama 30m) podie EN 5502 platl nésledujicl. Dojde-li k rullen! telekomunikataich nabo

finjich zafizeni e uivatal povinnen provést takova opatfgni, sty neni odstranl

fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures Polish Center forTesting and Certification
suivantes: Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit

que celui utilisé par le récepteur. The phasing conductor of the room's electrical

installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/T-42107

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou

<riDhér .
penpheniques and PN-89/E-06251.

CET APPAREIL NUMERIQUE DE LA CLASSE

B RESPECTE TOUTES LES EXIGENCES DU Wymagania Polskiego Centrum Badar i Certyfikacji
REGLEMENT SUR LE MATERIEL BROUILLEUR &:ﬁ:ﬁ'ﬁ;ﬂﬂﬂi:ﬁ?&f{$ﬂiﬂ&Kﬁ.".;“f.“c?“.'."w?.',’.“o,”5,'5‘&'{23‘;117.‘,.‘.5:“;;‘2”&“...k
DU CANADA. e s gy i o] o ko 160 (o perba

W el calkewitege wylpeeenia urqdzenia 2 sieer zasilanta, naledy wyjad wiyceke kabla
easilaigeepo 2 priaedka, kidre powinno enjdowad sig w poblia udemna 1 b Batwo dostepne.
Tnak bespiecaefarw "B patwiendes 2podaosé uresdienia  wynaganiami hespiecaeistua
wkytkowania cowanyimi w PN-SETAZI07 § PR-E 6251

Pozostale instrukcje begpieczensiwa

* i nalety ukywad wryczek adaptercwych Tub usuwaé kolka abwodu ochronnego 2 wiycaki,
Jepeli kosoczne jost iy peacdluzaczs  nalezy uzyt preodiuiacea -iylowega 2

Sy-cln.'m ¥ maleiy ieceyd preed nagtymi, i wrrostami bub spad-
Vs mapigei, wdywajas elimnalors prospiss, urradsenia depasaajicege b

berzakiicenivweia frodia zasilania.

* Nalezy upewitié sig. sby n e lezalo na ksblach systemu kompulerowess. araz aby kable nie
byky umieszczone w mlegscu, gdzie modna byloby na nic nadeptywad lub porykad sie o ie.

* i maleiy rorlwad nspaiow i nayeh plyaiw s systens koaputesony.

Nie malezy wpychat sacnych p i systemm o, guvi moke

to spowodwai poiar Iuhpmlm\e;r.(dmu poprzes rwarcie elementim wewngtrenych

* System komputerowy powisien znajdowad sig 2 dala od grzejaikiw : fidel elepla. Porsdro,

e ey blakawad atwordw wenylacynych. Nalezy unikac kludensa luinyeh papierdw pod

karmputera w i cyrhalacii powi-
etz wokil niego.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZEARERIIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



. Lovmassige oplysninger
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Kundeservice og garanti

8.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skeerm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
geelder i hele verden.

sub-pixler sub-pixler  sub-pixler

VT

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primaerfarverne red, gren og
bla. Nar mange pixler szttes sammen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser; fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er marke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstar som
enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstdr pa skeermbilledet, nar skeermen viser et
merkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gron eller bld sub-pixel.

I C

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla

- Red + Gren = Gul

- Grgn + Bla = Cyan (Lysebld)

Tre sammenliggende teendte pixler (en hvid
pixel).
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@ Bemaerk

En rad eller bla lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gren lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte merke prikker

Defekte mgrke prikker fremkommer som
pixels eller underpixels, der altid er marke
eller er “slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et merkt menster. Der er
folgende typer defekte marke prikker.

Tetsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger taet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for tetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskeerm have pixel- eller sub-pixeldefekter;
der overskrider de tolerancer, der er gengivet i
felgende tabeller.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

Tre sammenliggende taendte sub-pixler (en hvid pixel) 0

Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 merk sub-pixel 5 eller feerre

2 sammenliggende marke sub-pixler 2 eller ferre

3 sammenliggende mearke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller ferre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller ferre

@ Bemaerk
1.
2.

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1S09241-307 (1ISO9241-307: Testmetoder for

ergonimiske kray, analyse og overensstemmelse pa elektroniske visuelle skaerme)
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8.2 Kundeservice og garanti

For oplysninger om garantidaekning og geeldende stattekrav i dit omrdde, bedes du besgge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

A

Germany Siemens 1&S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens |1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

d 3 e e A

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
;egt;'; fegm NA Kim Tec d.o.0. +381 11 20 70 684
Slovenia NA PC Hand +386 1 530 08 24
e NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
E— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware ‘ +36 12426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

- Vermont
Argentina

Kundeservice tif
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tIf: 4008 800 008

Kontaktoplysninger til NORDAMERIKA:

and a e -

USA. TOS Teleplan

(877) 835-1838

Canada Supercom Supercom

(800) 479-6696
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Kontaktoplysninger til APMEA:

Land

Callcenter

ASC

Kundeservice tif

Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | . -\ Tel. (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
. . . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
United Arab 0 AL SHAHD COMPUTER LLL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
. : +84 8 38248007 Ho Chi Minh City
Vietnam NA FCPT Serv'cft'd”forma“c +84 5113.562666 Danang City
ompany Hte. +84 5113.562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no dllstrlbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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9. Fejlfinding og FAQ

9.1 Fejlfinding

Denne side omhandler problemer, som kan

klares af brugeren selv. Hvis problemet stadig er

der; efter at du har prevet disse lasninger, skal
du kontakte Philips' kundeservice.

a Almindelige problemer

Intet billede (stremdiode lyser ikke)
* Kontroller, at ledningen er sat |
stikkontakten og bag pa skaermen.

e Kontroller farst, at stramkontakten foran
pa skaermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
*  Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

»  Kontroller; at der ikke er nogen bgjede

stikben pa signalkablets stik. Hvis der er det,

skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

*  Tjek, om skeermkablets stikben er bgjede.

» Kontroller, at der er tendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.
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& Bemark
Den automatiske funktion er ikke ngdvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
*  Forsgg ikke selv at fejlfinde

e Trek straks skeermens stik ud af
stikkontakten

* Kontakt straks en repreesentant fra Philips
kundeafdeling.

2] Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skarmen
* Tjek, at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

|

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Billedet er slgret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.



Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
"“spogelsesbilleder” pa skaermen.
“Breendmaerker”, “efterbilleder”, og
"“spagelsesbilleder” er et velkendt faanomen
i LCD skermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
"“spagelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

*  Serg altid for at aktivere en pauseskeerm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskarm eller
et andet program, der opdaterer skeermen
regelmassigt, hvis LCD skeermen viser
statisk materiale i leengere perioden

*  Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller “spagelsesbillede”-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvranget.Tekst er utydelig eller

sloret.

* Indstil pc’ens skeermoplgsning som
skaermens anbefalede, native oplgsning.

Der ses rgde, bld, merke og hvide pletter pa

skaermen

*  De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Taendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Teendt” lyset med
Stremdiode i OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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9.2 Ofte stillede spargsmal om

SmartControl Lite

SP1. Jeg har udskiftet skeermen pé en pc

til en anden skaerm, og nu fungerer

SmartControl Lite ikke lengere. Hvad

skal jeg gore?

Sv.. Genstart din pc og se, om SmartControl
Lite fungerer nu. Ellers skal du afinstallere
og geninstallere SmartControl Lite for at
sikre, at den korrekte driver er installeret.

SP2. SmartControl Lite fungerede fint
tidligere, men nu virker programmet
ikke leengere. Hvad skal jeg gore?

Sv..  Huvis nogle af de felgende handlinger har
veeret udfert, skal skeermdriveren maske
geninstalleres.

* Videografikadapteren er blevet udskiftet

med en anden

* Opdater videodriver

e Aktiviteter i OS som f.eks. servicepakke
eller programrettelse

*  Opdater Windows og opdater skeerm- og/
eller videodriver

¢ Windows blev startet med stremmen til
skeermen slaet fra eller afbrudt.

e For at finde ud af dette, skal du klikke
pa My Computer (Denne Computer)
og derefter pa Properties (Egenskaber)
-> Hardware -> Device Manager
(Enhedshandtering).

* Huvis du ser“Plug and Play Monitor” (Plug
& Play skaerm) under Monitor (Skaerm), skal
du geninstallere. Afinstallér SmartControl
Lite og geninstallér det.

SP3. Efter installation af SmartControl Lite
sker der ingenting, selv om jeg klikker pa
fanen SmartControl Lite og venter, eller
der vises en fejlmeddelelse. Hvorfor?

Sv.:  Det skyldes muligvis, at din grafiske
adapter ikke er kompatibel med
SmartControl Lite. Hvis grafikadapteren
er en af ovennaevnte maerker, skal
du preve at downloade den mest



SP4.

Sv.:

opdaterede grafikadapterdriver fra det
pageldende firmas hjemmeside.

Installer driveren. Afinstallér SmartControl
Lite og geninstallér det igen.

Huvis det stadig ikke virker, er vi bange for,
at grafikadapteren ikke understattes. G til
Philips hjemmeside og kontrollér, om der
findes en nyere driver til SmartControl
Lite.

Nar jeg klikker pa Product Information
(Produktinformation), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan vare, at din
grafikkortadapterdriver ikke er den

mest opdaterede version, som fuldt ud
understgtter DCC/CI greensefladen. Prav
at downloade den mest opdaterede
grafikkortadapterdriver fra det
pageeldende firmas hjemmeside. Installer
driveren. Afinstallér SmartControl Lite og
geninstallér det igen.

Attention

Theft mode enabled

SP5 Jeg har glemt min PIN-kode til Theft

Sv.:

Deterrence (Anti-tyveri) funktionen.
Hvad gor jeg!

Philips servicecenter forbeholder sig
retten til at bede om legitimation og
godkendelse, for at kunne etablere
skaermens ejer.

Bemark venligst at anti-tyveri-funktionen
leveres som gratis ekstraudstyr. Det
eneste ansvar for den individuelle bruger
eller organisation, er at administrere
PIN-koden. Hvis PIN-koden glemmes, kan
Philips kundeservicecenter nulstille koden
for at almindeligt gebyr, nar brugeren har
bekraftet ejerskab af udstyret. Bemaerk
venligst at denne handling ikke er deekket
af standard garantien.

SP2

Sv.:

SP3:

Sv.:
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Generelle FAQ

: Hvad skal jeg gare, hvis skeermen under
installationen viser “Cannot display
this video mode” (Kan ikke vise denne
videotilstand)?
Den anbefalede oplgsning pa denne
skaerm: 1920 x 1080 pa 60 Hz.
Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte for.

I Windows Start Manu (Windows
Startmenuen), veelg Settings/Control Panel
(Indstillinger/Kontrolpanel). | Control

Panel (Kontrolpanel)-vinduet veelg Display
(Skeerm)-ikonet. | Egenskaber for Skeerm-
vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjaelken pa
1920x1080 pixler:

Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

Genstart computeren og gentag trinene
2 og 3 og bekreeft, at pc'en er indstillet til
1920x1080 ved 60 Hz.

Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skaermen.

Teend for skermen og derefter for pc'en.

: Hvad er den anbefalede

opdateringshastighed pa LCD skarmen?
Den anbefalede opdateringshastighed

pa LCD skaeerme er 60 Hz. | tilfelde af
forstyrrelser pa skeermen skal du satte
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(:inf og .icm)?

Dette er skeermens driverfiler: Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skaermdrivere (.inf og .icm filer) eller om
en driverdisk, ndr du installerer skaermen



SP4
Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

forste gang. Indsaet (medfelgende cd-rom)
i pakken i henhold til vejledningerne.
Skaermdrivere (inf og .icm filer) installeres
automatisk.

: Hvordan justerer jeg oplasningen?
Skaermkortet/grafikdriveren og skaermen
bestemmer sammen opl@sningerne til
radighed. Du kan veelge den gnskede
oplgsning under “Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skermen?

Sa skal du blot trykke pa OK og derefter
vaelge “Reset” (Nulstil) for at ga tilbage il
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udseette
skaermens overflade for kraftige stad.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skeermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renggr jeg LCD skaermens
overflade!?

Til normal renggring skal du blot anvende
en ren, blgd klud.Til kraftigere renggring
skal du bruge isopropylalkohol. Brug

ikke andre opl@sningsmidler saisom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg ®ndre skaermens farveindstilling?

Ja, du kan andre farveindstillingen via
OSD pa felgende made:
Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow” (Ned-pil) for
at veelge indstillingen "“Color” (Farve),
og tryk derefter pa "OK" for at angive
farveindstillingen. Der er tre indstillingen,
som vist nedenfor.

1. ColorTemperature (Farvetemperatur) -
Med indstillinger i 6500K omradet virker
skaermen “varm” med en rgd-hvid
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arvetone, mens en 9300K temperatur
giver en "kold bla-hvid farvetone”.

sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

User Define (Brugerdefineret) -
brugeren kan velge sin foretrukne
farveindstilling ved at indstille den rede,
grenne og bla farve.

& Bemerk
En malning af farven pa lys, der udstrdles fra

et objekt, mens det opvarmes. Denne maling

udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rede,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur, 6504K, er hvid.

SP9:

Sv.:

SP10:
Sv.:

SP11:

Sv.:

Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skeaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skeermen til dit Mac-system. Vi anbefaler,
at du kontakter Philips salgsrepraesentant
for yderligere oplysninger.

Er Philips LCD skarme “Plug & Play”?
Ja, skeermene er “Plug & Play" kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

Hvad er “billedklebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
leengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skaermen.
“Breendmeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt
feenomen i LCD skermteknologi. | de
fleste tilfeelde vil “brandmerkerne” eller
“efterbilledet” eller “spggelsesbilledet”



9. Fejlfinding og FAQ

forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskaerm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskzerm

eller et andet program, der opdaterer
skaermen regelmaessigt, hvis LCD
skaermen viser statisk materiale i leengere
perioder.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede”-
eller “spggelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennavnte skade
er ikke deekket af garantien.

SP12: Hvorfor viser skermen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

Din LCD monitor virker bedst pa dens
native oplgsning pa 1920 x 1080 ved

60 Hz. Brug denne oplasning for at opna
det bedste billede.
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